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＜参考＞ 
 

1. 国際勧告等の関連 

 本標準に関する国際勧告はない。 

 

2. 改版の履歴 

 

版数 制定日 改版内容 
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3. 工業所有権 

 本標準に関わる「工業所有権の実施の権利に係る確認書」の提出状況は、TTC ホームページで公開されて

いる。 

 

4. 標準作成部門 

メディア符号化専門委員会 

 

 
  



－ 7 － ＪＪ－４０．２０ 

 

 

1 はじめに 

本標準は、NGN 環境下にて JT-Q3402 に従った SIP による呼確立後、SOAP/HTTP を利用して通信システム

間でコンテンツの送受信を実現するために作成した。 

 

2 参照文献 

本標準で参照する文献を以下に示す。 

 

[MIME]        "IANA MIME Media Types http://www.iana.org/assignments/media-type/",IANA 

[Q3402] "NGN UNI シグナリングプロファイル プロトコルセット 1 (NGN UNI Signalling Profile 

(Protocol Set 1))", TTC 標 準  JT-Q3402 第 1.0 版 , 情 報 通 信 技 術 委 員 会  (The 

Telecommunication Technologies Committee), 2009 年 5 月 
[RFC1867] "Form-based File Upload in HTML", RFC 1867, IETF, 1995 年 11 月 
[RFC2046] "Multipurpose Internet Mail Extensions (MIME) Part Two: Media Types", RFC 2046, IETF, 1996

年 11 月 
[RFC2388] "Returning Values from Forms:  multipart/form-data", RFC 2388, IETF, 1998 年 8 月 

[RFC2616] "Hypertext Transfer Protocol", RFC 2616, IETF, 1999 年 6 月 

[RFC2854] "The "text/html" Media Type ", RFC 2854, IETF, 2000 年 6 月 

[RFC3902] "The "application/soap+xml" media type", RFC 3902, IETF, 2004 年 9 月 

[RFC4145] "セッション記述プロトコル（SDP）における TCP ベースのメディアトランスポート

(TCP-Based Media Transport in the Session Description Protocol (SDP))", TTC 標 準 

JF-IETF-RFC4145, 情報通信技術委員会 (The Telecommunication Technologies Committee), 

2007 年 3 月 

[RFC5234] "Augmented BNF for Syntax Specifications: ABNF", RFC 5234, IETF, 2008 年 1 月 

[SOAP] "SOAP Version1.2 Part1:Messaging Framework (Second Edition)", W3C, 2007 年 4 月 

 "SOAP Version1.2 Part2:Adjuncts (Second Edition)", W3C, 2007 年 4 月 

[XML] "Extensible Markup Language(XML) 1.0 (Fifth Edition)", W3C, 2008 年 11 月 

[XML Namespaces] "Namespaces in XML 1.0 (Third Edition)", W3C, 2009 年 12 月 

[XML Schema] "XML Schema Part0: Primer Second Edition", W3C, 2004 年 10 月 

 "XML Schema Part1: Structures Second Edition", W3C, 2004 年 10 月 

 "XML Schema Part2: Datatypes Second Edition", W3C, 2004 年 10 月 
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3 用語 

コンテンツ : 画像、映像、文書等のデジタルデータ 

コンテンツ転送 : コンテンツを送り届けること 

アウトチャネル : 電話番号を利用し、呼設定を行う信号チャネル 

インチャネル : アウトチャネルにて呼設定後、機器間でメディア情報をやりとりするチャネル 

発呼  : 電話番号を使って呼設定の要求を開始すること 

着呼  : 呼設定の要求を受信すること 

発呼機器  : 本標準で規定する通信手順を用いて呼設定の要求をする機器 

着呼機器  : 本標準で規定する通信手順を用いて呼設定の要求を受信する機器 

機器  : 発呼機器、着呼機器を示す 

送信機能  : 本標準で規定する通信手順を用いてコンテンツを送信する機能 

受信機能  : 本標準で規定する通信手順を用いてコンテンツを受信する機能 

クライアント機能 : コンテンツ転送を行うための要求を送信する機能 

サーバ機能 : コンテンツ転送を行うための要求を受け付ける機能 

NGN  : 電話・データ通信・ストリーミング放送が融合したマルチメディアサービスを 

実現する、インターネットプロトコル技術を利用する次世代ネットワーク 

（Next Generation Network） 

UNI        : 通信事業者の通信設備とエンドユーザー側の設備とを接続するインターフェース仕

様（User-Network Interface） 

BN 記法  : バッカス・ナウア記法（Backus-Naur Form）のこと。文脈自由文法を定義するのに 

用いられるメタ言語のことで、プロトコル規定言語である ASN.1 や、XML の構文 

定義に利用されている 

HTTP  : サーバとクライアント間でデータを送受信するのに使われるプロトコル 

XML  : 文書やデータの意味や構造を記述するためのマークアップ言語 

SOAP  : XML と HTTP などをベースとした、他のコンピュータにあるデータやサービスを 

読み出すためのプロトコル 

SOAP HTTP Binding : SOAP メッセージの伝送に HTTP リクエスト及びその HTTP レスポンスを 

利用すること 

準正常系  : 規定通りの動作を行っても組み合わせによっては起こりうるケース 

異常系  : 利用上、特別なことを行った、または行われた結果起こる異常なケース 
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4 本標準の構成 

本標準は、本編として、コンテンツファイルの取得、送信、受信の基本的な通信プロトコルを規定し、付属

資料は本編を基本として付加的な情報を伝えるためのプロトコルを規定する構成とする。付加的な情報とは、

本編の規定を拡張して、送信機器、受信機器でコンテンツファイルを扱うための情報である。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 4-1／JJ-40.20 本標準の構成 

 

4.1 本標準の改版 

本編及び付属資料の内容が改版されたとき、本標準を改版する。改版によってプロトコルが変更される場合

は、9.1 項のプロトコルバーションを改版する。 

 

4.2 注意事項 

4.2.1 構文の記述 

本標準で記述する XML 文書は、BN 記法に従い記述する。 

各構文の記述内容は、2 項の各参考文献を参照のこと。 

 

4.2.2 XML要素のネームスペース 

本プロトコルで定義する XML 要素のネームスペースは 

 

本編 :  http://www.ttc.or.jp/mmsys/ct 

 

とする。 

 

 
  

■本編 

コンテンツの取得、送信、受信を提供するアプリケーションの基礎的な動作を規定する  

 

 

 

 

 

■付属資料 

本編を基本として、特定のアプリケーションに必要とされる付加的な動作を規定する 

■Annex・・ ■AnnexB 
■AnnexA 
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5 システムモデル 

コンテンツ転送システムにおける送信処理について、データの流れから見た典型的な送信機器モデルを 図 

5-1 に示す。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 5-1／JJ-40.20 データの流れから見た送信機器モデル 
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コンテンツ転送システムにおける受信処理について、データの流れから見た典型的な受信機器モデルを 図 

5-2 に示す。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 5-2／JJ-40.20 データの流れから見た受信機器モデル 
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6 プロトコル構成 

プロトコル構成は OSI 参照モデルに即した階層構造とする。 

JT-Q3402 に従い SIP による呼確立後、インチャネルで SOAP/HTTP を利用した本プロトコルによりコンテン

ツ転送を実現する。本プロトコルはインチャネルのプロトコル規定のため、NGN に限らず何らかの手段で

相手機器に接続した後に本プロトコルを使用してコンテンツ転送を実現することができる。 

 

表 6-1／JJ-40.20 プロトコル構成 

レイヤ 
使用プロトコル 

アウトチャネル インチャネル 

7 アプリケーション 

SIP,SDP 

SOAP 

HTTP 6 プレゼンテーション 

5 セッション 

4 トランスポート UDP TCP 

3 ネットワーク IPv4/IPv6 

2 データリンク Ethernet 等 

1 物理 

 

＜SOAP/HTTP 使用の理由＞ 

本コンテンツ転送プロトコルでは以下の理由によりインチャネルで SOAP/HTTP を利用する。 

(1) TCP コネクションを用いた通信プロトコルにおいて、HTTP が最も利用されているプロトコ

ルである。 

(2) SOAP は WEB サービスの広まりと共にリモート・プロシージャ・コール(RPC)の標準として

利用されている。 

(3) 多くの開発環境が整備されており、短期間での開発が可能である。 

(4)  SOAP 上で関数定義が自由に実現できるため拡張が容易である。 

 

6.1 SIP、SDP 

本プロトコルで規定するコンテンツ転送は、SIP セッションの中で行う。 

TTC 標準 JT-Q3402 に準拠する。 

 

6.2 TCP 

HTTP パケットの転送に関して、トランスポート層のプロトコルとして JF-IETF-RFC4145 に従い TCP を利用

する。 

 

6.3 HTTP 

コンテンツ転送に利用する。RFC2616（HTTP1.1）に準拠する。 

また、SOAP メッセージを HTTP のメッセージボディに載せて通信相手に送る。（SOAP HTTP Binding） 
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6.4 SOAP 

SOAP1.2[SOAP]に準拠する。 

 

6.5 SOAP HTTP Binding 

SOAP Version1.2 Part2[SOAP]に従い、SOAP メッセージの伝送に HTTP リクエスト及びその HTTP レスポン

スを利用する。SOAP Request-Response Message Exchange パターンに準拠する。 
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7 プロトコルの規定範囲 

7.1 規定範囲 

本プロトコルは，アウトチャネルにて JT-Q3402 に従い SIP による呼確立後、SOAP/HTTP を利用したインチ

ャネルのプロトコルを 3 つ規定し、機器間のコンテンツの転送を実現する。 

 

7.1.1 インチャネルプロトコル規定１ 

発呼機器からコンテンツが複数保管されているコンテンツサーバに発呼し、コンテンツサーバからのコンテ

ンツリストを基に発呼機器がコンテンツを取得する接続形態のプロトコル規定。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 7-1／JJ-40.20 インチャネルプロトコル規定 1 の範囲 
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7.1.2 インチャネルプロトコル規定２ 

発呼機器から着呼機器に発呼し、発呼機器から着呼機器にコンテンツを送信する接続形態のプロトコル規定。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 7-2／JJ-40.20 インチャネルプロトコル規定 2 の範囲 

 

 

7.1.3 インチャネルプロトコル規定３ 

発呼機器から着呼機器に発呼し、着呼機器から発呼機器にコンテンツを送信する接続形態のプロトコル規定。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 7-3／JJ-40.20 インチャネルプロトコル規定 3 の範囲 
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7.2 アウトチャネルの接続形態 

アウトチャネルで行う、SIP/SDPによる呼設定は、表 7-1 に示す 2 つの形態を定義する。 

 

表 7-1／JJ-40.20 アウトチャネル接続形態の説明 

接続形態 説明 

1 単独呼 コンテンツ転送のみを行うために SIP セッションを確立する呼 

2 追加呼 
既に存在する、音声、映像、データ通信の呼に追加してコンテン

ツ転送を行うために SIP セッションを追加する呼 

 
 

7.3 インチャネルの接続形態 

インチャネルで行うコンテンツの転送方法は、表 7-2 に示す 3 つの接続形態を定義し、それぞれの接続形態

に表 7-3 のインチャネルプロトコル規定を適用する。 

 

表 7-2／JJ-40.20 インチャネル接続形態の説明 

接続形態 説明 

1 
発呼側 

コンテンツ取得 

発呼機器から着呼機器にあるコンテンツを取得する 

2 
発呼側 

コンテンツ送信 

発呼機器にあるコンテンツを発呼機器から着呼機器に送信する 

3 
着呼側 

コンテンツ送信 

着呼機器にあるコンテンツを着呼機器から発呼機器に送信する 

 

表 7-3／JJ-40.20 インチャネル接続形態とプロトコル規定の適用 

接続形態 適用するプロトコル規定 

1 
発呼側 

コンテンツ取得 

7.1.1 項「インチャネルプロトコル規定 1」 

2 
発呼側 

コンテンツ送信 

7.1.2 項「インチャネルプロトコル規定 2」 

3 
着呼側 

コンテンツ送信 

7.1.3 項「インチャネルプロトコル規定 3」 

 

 
  



－ 17 － ＪＪ－４０．２０ 

 

 

7.4 コンテンツ転送の各通信フェーズ 

コンテンツ転送には、SIP/SDP による呼を確立する呼設定フェーズ、呼を切断する呼切断フェーズを行うア

ウトチャネルと、呼確立後に TCP コネクションを確立するフェーズ、コンテンツ送信側からコンテンツ受信

側へ能力を問い合わせる能力通知・確認フェーズ、取得できるコンテンツの一覧を把握するコンテンツリス

ト取得フェーズ、コンテンツファイル転送のジョブを生成するジョブ生成フェーズ、コンテンツファイルを

転送するコンテンツ送信フェーズ、TCP コネクションを切断するフェーズを行うインチャネルが存在する。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 7-4／JJ-40.20 コンテンツ通信の各通信フェーズ 
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7.4.1 呼設定フェーズ 

本フェーズは、インチャネルでのコンテンツ転送を実施するに先立ち、呼を確立することを目的とする。 

 

7.4.2 TCPコネクション確立フェーズ 

本フェーズは、コンテンツ転送に先立ち、TCP コネクションを確立することを目的とする。本プロトコルで

は、「クライアントとして動作している機器からサーバとして動作している機器へ対して、TCP コネクショ

ンを開始するものとする。送信側は、受信側から SIP/SDP によって通知された待ち受けポートに対して、TCP

コネクションを張るものとする。本フェーズで確立した TCP コネクションの切断は、TCP コネクションを

張ったクライアントとして動作している機器から TCP コネクションの切断を行うものとする。サーバとして

動作している機器からは行わないものとする。TCP コネクションの確立方法については、TTC 標準 JT-Q3402

に準拠する。 

 

7.4.3 能力通知フェーズ 

本フェーズは、7.3 項の接続形態 1 において、コンテンツリスト取得フェーズに先立ち、受信側が送信側に

受信側の能力を通知することを目的とする。具体的には受信可能なコンテンツのフォーマット（MIME-TYPE）

を通知する。 

 

7.4.4 能力確認フェーズ 

本フェーズは、7.3 項の接続形態 2 と接続形態 3 において、ジョブ生成フェーズに先立ち、送信側が受信側

の能力の把握を行うことを目的とする。具体的には送信側は受信側で受信可能なコンテンツのフォーマット

（MIME-TYPE）を確認することができる。 

 

7.4.5 コンテンツリスト取得フェーズ 

本フェーズは、7.3 項の接続形態 1 において、コンテンツ取得フェーズに先立ち、受信側が送信側に送信側

に存在するコンテンツのリストを取得することを目的とする。 

 

7.4.6 ジョブ生成フェーズ 

本フェーズは、7.3 項の接続形態 2 と接続形態 3 において、コンテンツ送信フェーズに先立ち、送信側が受

信側に対して、ジョブ生成要求を行い受信側が受け入れるか否かを応答する。ジョブ生成要求には、これか

ら送信するコンテンツの情報（ファイル名、容量、MIME-TYPE等）が含まれる。 

 

7.4.7 コンテンツ取得フェーズ 

本フェーズは、7.3 項の接続形態 1 において、受信側は送信側に対してコンテンツリスト取得フェーズで取

得したコンテンツリストからコンテンツを選択し、HTTPプロトコルのGETメソッドを使い、コンテンツ取

得要求を行い、コンテンツを取得する。 

 

7.4.8 コンテンツ送信フェーズ 

本フェーズは、7.3 項の接続形態 2 と接続形態 3 において、送信側は受信側に対してHTTPプロトコルのPOST

メソッドを使い、HTTPメッセージボディに転送するファイルを含めて送信する。1 つのファイルを 1 つの

HTTPメッセージボディに含めるものとする。 
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7.4.9 TCPコネクション切断フェーズ 

本フェーズは、コンテンツ取得フェーズ、コンテンツ送信フェーズ終了後、TCP コネクションを切断するこ

とを目的とする。本プロトコルでは、TCP コネクションを張った機器から TCP コネクションを切断するこ

ととする。 

 

7.4.10 呼切断フェーズ 

本フェーズは、インチャネルでのコンテンツ転送終了後、呼を切断することを目的とする。 
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8 接続形態 

「7.2 アウトチャネルの接続形態」及び「7.3 インチャネルの接続形態」の接続形態について説明する。 

 

8.1 アウトチャネルの接続形態 

表 7-1 の接続形態について説明する。 

SIP による呼設定、呼切断は JT-Q3402 に従い、パラメータは JF-IETF-RFC4145 に従う。 

8.1.1 項、8.1.2 項に一例を示す。 

 

8.1.1 接続形態例 1（単独呼） 

コンテンツ転送のみを行うために SIP にて TCP セッションを確立する呼の接続形態例である。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※発呼機器からの切断を例に記述 

 

 

図 8-1／JJ-40.20 単独呼による発呼機器と着呼機器の通信の確立と切断の例 
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F3 <180 Ringing> F3 <180 Ringing> 
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F5 SIP 確認<ACK> F5 SIP 確認<ACK> 

インチャネル通信 

F6 SIP 切断<BYE> F6 SIP 切断<BYE> 

F7 SIP 切断確認<200 OK> F7 SIP 切断確認<200 OK> 

F2 <100 Trying> F2 <100 Trying> 

通信終了 
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8.1.2 接続形態例 2（追加呼） 

メディア（音声、映像、データ等）通信中にコンテンツ転送を行うために SIP にて TCP セッションを追加す

る呼の接続形態である。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※発呼機器からの音声、映像、データを同時に切断する例を記載 

 

 

図 8-2／JJ-40.20 追加呼による発呼機器と着呼機器の通信の確立と切断の例 
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通信終了 
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8.2 インチャネルの接続形態 

表 7-2 の接続形態について説明する。 

 

8.2.1 接続形態 1（発呼機器からのコンテンツ取得） 

本接続形態は、サーバとして動作する機器（着呼側）に複数のコンテンツが存在し、クライアントとして動

作する機器（発呼側）からサーバ側にある複数のコンテンツを選択して取得する。（クライアント、サーバ

動作の指定は 9.3 項を参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 8-3／JJ-40.20 接続形態 1 

・能力通知フェーズ 

呼設定後、発呼機器は着呼機器に対し、発呼機器で受信可能なコンテンツ種別の能力を通知する。 

 

・コンテンツリスト取得フェーズ 

着呼機器に存在する複数のコンテンツを並べた 1 つのリスト（コンテンツリスト）を取得するために、発呼

機器から着呼機器に対し、コンテンツリストの要求を行い、コンテンツリストを取得する。 

 

・コンテンツ取得フェーズ 

発呼機器は、コンテンツリストから選択されたコンテンツを取得するために、HTTP GET メソッドでコンテ

ンツ要求を行い、コンテンツを取得する。複数のコンテンツを取得する場合は、HTTP GET メソッドでのコ

ンテンツ要求を取得するコンテンツの数だけ繰り返し行う。 
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8.2.2 接続形態 2（発呼機器からのコンテンツ送信） 

本接続形態は、発呼機器をクライアントとして、着呼機器をサーバとして動作させ、発呼機器から着呼機器

にコンテンツを送信する。（クライアント、サーバ動作の指定は 9.3 項を参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 8-4／JJ-40.20 接続形態 2 

 

・能力確認フェーズ 

呼設定後、発呼機器は着呼機器に対し、着呼機器で受信可能なコンテンツ種別を確認するための要求を行い

着呼機器の能力を確認する。 

 

・ジョブ生成フェーズ 

発呼機器は、着呼機器に対し送信するコンテンツの容量やフォーマット等、受信するための条件を通知し、

着呼機器が受信できる状態であることを確認する。 

 

・コンテンツ送信フェーズ 

発呼機器は、着呼機器に対して HTTP POST メソッドでコンテンツを送信する。複数のコンテンツを送信す

る場合は、ジョブ生成フェーズからコンテンツ送信フェーズまでを、送信するコンテンツの数だけ繰り返し

行う。 
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8.2.3 接続形態 3（着呼機器からのコンテンツ送信） 

本接続形態は、着呼機器をクライアントとして、発呼機器をサーバとして動作させ、着呼機器から発呼機器

にコンテンツを送信する。（クライアント、サーバ動作の指定は 9.3 項を参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 8-5／JJ-40.20 接続形態 3 

 

・能力確認フェーズ 

呼設定後、コンテンツを送信する着呼機器はコンテンツを受信する発呼機器に対し、発呼機器で受信可能な

コンテンツ種別を確認するための要求を行い、コンテンツを受信する発呼機器の能力を確認する。 

 

・ジョブ生成フェーズ 

コンテンツを送信する着呼機器は、コンテンツを受信する発呼機器に対し送信するコンテンツの容量やフォ

ーマット等、受信するための条件を通知し、発呼機器が受信できる状態であることを確認する。 

 

・コンテンツ送信フェーズ 

コンテンツを送信する着呼機器は、コンテンツを受信する発呼機器に対して HTTP POST メソッドでコンテ

ンツを送信する。複数のコンテンツを送信する場合は、ジョブ生成フェーズからコンテンツ送信フェーズま

でを、送信するコンテンツの数だけ繰り返し行う。 
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9 コンテンツ転送プロトコルの詳細 

本仕様書で規定するインチャネルのコンテンツ転送プロトコルは、送信側から受信側に対するリクエストと、

受信側から送信側に対するレスポンスからなる。これらのリクエストとレスポンスは SOAP メッセージを利

用し、伝送プロトコルとして HTTP プロトコルを利用する。 

 

9.1 バージョンの表記 

本プロトコルのバージョンを能力通知（InformCapability）、能力通知応答（InformCapabilityResponse）、能力

確認要求（GetCapability）、能力確認応答（GetCapabilityResponse）の"ProtocolName" タグと"AgentName" タ

グに記載する。記載内容は表 9-1 の 2 種別とする。バージョンが改版された場合は下位互換を確保する。 

記述方法は、10.2.1 項、10.2.2 項、10.3.1 項、10.3.2 項を参照。 

 

表 9-1／JJ-40.20 記載するバージョンの種別 

種別 内容 

プロトコル種別 
本プロトコルの名称とバージョンを表す 

バージョンが改版された場合は下位互換を確保する 

機器種別 
本プロトコルを実装した機器（アプリケーション含む）の名称とバージョ

ンを表す 

 

表 9-2／JJ-40.20 設定する内容 

種別 項目 設定内容 

プロトコル種別 
プロトコル名 "ContentsTransfer"を設定する 

プロトコルバージョン "1.0"を設定する 

機器種別 

機器名 

（アプリケーション名） 

自由設定とする 

ただし RFC2616 に従う 

機器バージョン 

（アプリケーションバージョン） 

自由設定とする 

ただし RFC2616 に従う 

 

表 9-3／JJ-40.20 JJ-40.20 の版数とプロトコル識別の設定内容 

JJ-40.20 の版数 プロトコル種別 設定内容 

1.2 版 
プロトコル名 "ContentsTransfer"を設定する 

プロトコルバージョン "1.0"を設定する 
 

9.2 バージョンの扱い方 

9.2.1 プロトコル識別 

プロトコル種別のバージョンが改版された場合は下位互換を確保する。 

能力通知（InformCapability）と能力通知応答（InformCapabilityResponse）、あるいは能力確認要求（GetCapability）

と能力確認応答（GetCapabilityResponse）の"ProtocolName" タグに記載されているプロトコル識別のプロト

コルバージョンが違う場合は下位バーションで動作する。 
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9.2.2 機器識別 

機器種別は、本プロトコルを実装した機器名称を自由に設定することができる。 

能力通知（InformCapability）と能力通知応答（InformCapabilityResponse）、あるいは能力確認要求（GetCapability）

と能力確認応答（GetCapabilityResponse）の"AgentName" タグに記載されている機器種別を同じと見なした

場合は、送信機器と受信機器間で利用できるSOAPアクションを独自に定義してもよい。独自に定義する

SOAPメッセージの先頭に「x-」または「X-」を記述すること。（10.1.3 項参照） 

本プロトコルで規定しているSOAPアクションに設けている "Private" タグの子要素に送信機器と受信機器

間で利用できる変数（タグ）を独自に定義してもよい。独自に定義する変数（タグ）名の先頭に「x-」また

は「X-」を記述すること。（10.1.4 項参照） 

機器名（アプリケーション名）が違った場合の動作は、独自に定義した SOAP アクションと"Private" タグの

子要素に独自に定義した変数（タグ）は無視し、本プロトコルで規定する動作を行う。 

 

9.3 発呼機器と着呼機器の動作 

発呼機器と着呼機器はそれぞれ、クライアントとして動作するか、サーバとして動作することになる。クラ

イアント、サーバのどちらで動作するかを SIP の SDP（a 行）により決定する。 

 

表 9-4／JJ-40.20 発呼機器と着呼機器の動作 

アウトチャネル 

発呼機器の 着呼機器の 

SDP a 行 動作 SDP a 行 動作 

a=setup:active 

に設定 

クライアントとして動作 a=setup:passive 

に設定 

サーバとして動作 

a=setup:passive 

に設定 

サーバとして動作 a=setup:active 

に設定 

クライアントとして動作 
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9.4 リクエストメッセージの生成 

9.4.1 HTTPヘッダの設定 

使用する HTTP バージョンは、持続的接続を利用するため HTTP 1.1 とする。 

 

表 9-5／JJ-40.20 リクエストの HTTP ヘッダ 

変数 設定内容 

Request-Line  

 Method ・"POST"を設定する 

 Request-URI ・"/soap_action"を設定する 

 HTTP-Version ・"HTTP/1.1"を設定する 

Request-Header  

 Accept ・本ヘッダを設定する場合には"application/soap+xml"を設定する 

 Accept-Encoding ・本ヘッダは設定しない 

 Expect ・本ヘッダを設定する場合には“100-continue”を設定する。 

 Host ・送信先の FQDN が不明の場合には、host 部に IP アドレスを設定する

・port 番号には、送信先の HTTP サーバの待ち受けポート番号を設定

する 

 User-Agent ・本ヘッダは設定しない*1 

General-Header  

 Connection ・続けて HTTP リクエストを送出する場合は"Keep-Alive"を設定する 

・続けて HTTP リクエストを送出しない場合は" Close "を設定する 

 Date ・HTTP リクエストを生成した時刻を設定する 

Entity-Header  

 Content-Encoding ・本ヘッダは設定しない 

 Content-Type ・"application/soap+xml"を設定する 

  charset ・"utf-8"を設定する 

  action ・本パラメータは設定しない 

 Content-Length ・HTTP-Body のサイズ（バイト数）を設定する 
*1：付録 A を参照 

 

9.4.1.1 暫定応答要求 

本プロトコルはHTTP1.1 を使用しているため、クライアントとして動作している機器は、リクエストのHTTP

ヘッダに「Expect: 100-Continue」を付加してもよい。サーバとして動作している機器は、「Expect: 100-Continue」

を受け取った場合は「HTTP/1.1 100 Continue」を返送しなければならない。シーケンスは 9.7 項を参照のこ

と。 
さらに、セッション持続要求に関するSOAPアクション（10.2.8 項、10.3.7 項）を実施すること。 
 
 
  



－ 28 － ＪＪ－４０．２０ 

 

 

9.4.2 SOAPメッセージの設定 

使用する SOAP バージョンは、SOAP 1.2 とする。 

以降特に断りがない場合は、SOAP メッセージ内で使用できる文字のエンコーディングは UTF-8 とする。 

 

表 9-6／JJ-40.20 リクエストの SOAP メッセージ 

設定内容 備考 

<?xml version="1.0" encoding=” UTF-8” ?>  

<env:Envelope 

xmlns:env="http://www.w3.org/2003/05/soap-envelope"  

xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

 

 <env:Body>  

  <request-method-name 

env:encodingStyle="http://www.w3.org/2003/05/soap-encoding" 

xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

request-method-name の部分に

リクエストメソッド名を設定

する 

  <（引数）>  

 

9.4.2.1 ネームスペース 

本プロトコルで定義するXML要素のネームスペースは 4.2.2 項を参照する。 
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9.5 レスポンスメッセージの生成 

9.5.1 HTTPヘッダの設定 

使用する HTTP バージョンは、持続的接続を利用するため HTTP 1.1 とする。 

 

表 9-7／JJ-40.20 レスポンスの HTTP ヘッダ 

変数 設定内容 

Status-Line  

 HTTP-Version ・"HTTP/1.1"を設定する 

 Status-Code ・"100"を設定する 

 Reason-Phrase ・"continue"を設定する 

Request-Header  

 Server ・本ヘッダは設定しない*1 

General-Header  

 Connection ・"Keep-Alive"を設定する 

 Date ・HTTP レスポンスを生成した時刻を設定する 

Entity-Header  

 Content-Encoding ・本ヘッダは設定しない 

 Content-Type ・"application/soap+xml"を設定する 

  charset ・"utf-8"を設定する 

  action ・本パラメータは設定しない 

 Content-Length ・HTTP-Body のサイズ（バイト数）を設定する 

*1：付録 A を参照 

 

9.5.1.1 暫定応答 

クライアントとして動作している機器からのリクエストのHTTPヘッダに「Expect: 100-continue」が付与され

ている場合、サーバとして動作している機器は「HTTP/1.1 100 Continue」のレスポンスを返すこと。シーケ

ンスは 9.7 項を参照のこと。 
さらに、セッション持続要求に関するSOAPアクション（10.2.8 項、10.3.7 項）を実施すること。 
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9.5.2 SOAPメッセージの設定 

使用する SOAP バージョンは、SOAP 1.2 とする。 

以降特に断りがない場合は、SOAP メッセージ内で使用できる文字のエンコーディングは UTF-8 とする。 

 

表 9-8／JJ-40.20 レスポンスの SOAP メッセージ 

設定内容 備考 

<?xml version="1.0" encoding=”UTF-8” ?>  

<env:Envelope 

xmlns:env="http://www.w3.org/2003/05/soap-envelope"  

xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

 

 <env:Body>  

  <request-method-name 

env:encodingStyle="http://www.w3.org/2003/05/soap-encoding" 

xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

request-method-name の部分に

リクエストメソッド名を設定

する 

  <（引数）>  

 

9.5.2.1 ネームスペース 

本プロトコルで定義するXML要素のネームスペースは 4.2.2 項を参照する。 
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9.6 SOAPアクションの要求と取得 

能力通知（InformCapability）と能力通知応答（InformCapabilityResponse）、あるいは能力確認要求（GetCapability）

と能力確認応答（GetCapabilityResponse）の"AgentName" タグに記載されている機器種別を同じと見なした

場合は、送信機器と受信機器間で利用できる SOAP アクションを定義して使用してもよいが、今後、SOAP

アクションが追加されたとき、送信機器と受信機器間で追加された SOAP アクションを把握するために、

SOAP アクションリスト要求を行い、サーバとして動作する機器の SOAP アクションを把握する手段を設け

る。 

HTTP GET メソッドによる「/soap_action」の送信を、SOAP アクションリストの要求とする。 

なお、具体的なメッセージについては、今後規定する。 

 

 

 

 

 

 

 

 

図 9-1／JJ-40.20 SOAP アクションリストの要求方法 
 

9.7 接続形態のシーケンス 

本標準で規定する SOAP アクションを使用したインチャネルのコンテンツ転送プロトコルには 3 つの接続形

態がありそのシーケンスを記述する。 

 

インチャネル接続形態 1 : 発呼機器からのコンテンツ取得 

インチャネル接続形態 2 : 発呼機器からのコンテンツ送信 

インチャネル接続形態 3 : 着呼機器からのコンテンツ送信 

 

 
  

着呼機器 

着呼機器が実装している 
SOAP アクションリストの要求 

発呼機器 

SOAP アクションリスト 
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9.7.1 発呼機器からのコンテンツ取得 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 9-2／JJ-40.20 インチャネル接続形態 1:発呼機器からのコンテンツ取得のシーケンス図 

 

発呼機器 SIP サーバ 着呼機器 

呼設定フェーズ 

TCP セッション確立フェーズ 

能力通知フェーズ 

F13 能力通知<HTTP POST> 

F14 能力通知応答<HTTP 200 OK> 

コンテンツリスト取得フェーズ 

コンテンツ取得フェーズ 

TCP セッション切断フェーズ 

F17 コンテンツリスト取得要求<HTTP POST> 

F18 コンテンツリスト取得応答<HTTP 200 OK> 

F21 コンテンツ 1 取得要求<HTTP GET> 

F22 コンテンツ 1 取得送信<HTTP 200 OK> 

呼切断フェーズ 

F25 コンテンツ n 取得要求<HTTP GET> 

F26 コンテンツ n 取得送信<HTTP 200 OK> 

アウト 
チャネル 

イン 
チャネル 

アウト 
チャネル 

F11 暫定応答要求<Expect: 100-continue> 

F12 暫定応答< HTTP/1.1 100 Continue > 

F15 暫定応答要求<Expect: 100-continue> 

F16 暫定応答< HTTP/1.1 100 Continue > 

F19 暫定応答要求<Expect: 100-continue> 

F20 暫定応答< HTTP/1.1 100 Continue > 

F23 暫定応答要求<Expect: 100-continue> 

F24 暫定応答< HTTP/1.1 100 Continue > 
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9.7.2 発呼機器からのコンテンツ送信 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 9-3／JJ-40.20 インチャネル接続形態 2:発呼機器からのコンテンツ送信のシーケンス図 

SIP サーバ 着呼機器 

呼設定フェーズ 

TCP セッション確立フェーズ 

能力確認フェーズ 

F29 能力確認要求<HTTP POST> 

F30 能力確認応答<HTTP 200 OK> 

ジョブ生成フェーズ 

コンテンツ送信フェーズ 

TCP セッション切断フェーズ 

F33 ジョブ開始要求<HTTP POST> 

F34 ジョブ開始応答<HTTP 200 OK> 

F37 コンテンツ 1 送信<HTTP POST> 

F38 コンテンツ 1 送信応答<HTTP 200 OK> 

呼切断フェーズ 

アウト 
チャネル 

イン 
チャネル 

アウト 
チャネル 

発呼機器 

ジョブ生成フェーズ 

コンテンツ送信フェーズ 

F41 ジョブ開始要求<HTTP POST> 

F42 ジョブ開始応答<HTTP 200 OK> 

F45 コンテンツ n 送信<HTTP POST> 

F46 コンテンツ n 送信応答<HTTP 200 OK> 

F27 暫定応答要求<Expect: 100-Continue> 

F28 暫定応答< HTTP/1.1 100 Continue > 

F31 暫定応答要求<Expect: 100-Continue> 

F32 暫定応答< HTTP/1.1 100 Continue > 

F35 暫定応答要求<Expect: 100-Continue> 

F36 暫定応答< HTTP/1.1 100 Continue > 

F39 暫定応答要求<Expect: 100-Continue> 

F40 暫定応答< HTTP/1.1 100 Continue > 

F43 暫定応答要求<Expect: 100-Continue> 

F44 暫定応答< HTTP/1.1 100 Continue > 
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9.7.3 着呼機器からのコンテンツ送信 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 9-4／JJ-40.20 インチャネル接続形態 3:着呼機器からのコンテンツ送信のシーケンス図 
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能力確認フェーズ 

F29 能力確認要求<HTTP POST> 

F30 能力確認応答<HTTP 200 OK> 

ジョブ生成フェーズ 

コンテンツ送信フェーズ 

TCP セッション切断フェーズ 

F33 ジョブ開始要求<HTTP POST> 

F34 ジョブ開始応答<HTTP 200 OK> 

F37 コンテンツ 1 送信<HTTP POST> 

F38 コンテンツ 1 送信応答<HTTP 200 OK> 

呼切断フェーズ 
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F41 ジョブ開始要求<HTTP POST> 

F42 ジョブ開始応答<HTTP 200 OK> 

F45 コンテンツ n 送信<HTTP POST> 

F46 コンテンツ n 送信応答<HTTP 200 OK> 

F27 暫定応答要求<Expect: 100-Continue> 

F28 暫定応答< HTTP/1.1 100 Continue > 

F31 暫定応答要求<Expect: 100-Continue> 

F32 暫定応答< HTTP/1.1 100 Continue > 

F35 暫定応答要求<Expect: 100-Continue> 

F36 暫定応答< HTTP/1.1 100 Continue > 

F39 暫定応答要求<Expect: 100-Continue> 

F40 暫定応答< HTTP/1.1 100 Continue > 

F43 暫定応答要求<Expect: 100-Continue> 

F44 暫定応答< HTTP/1.1 100 Continue > 
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10 SOAPアクションの規定 

10.1 注意事項 

10.1.1 変数（タグ）のM/Oの扱い 

各 SOAP メッセージの変数（タグ）には「M/O」が規定されており、「M」は Mandatory の略であり必須タグ、

「O」は Option の略でありオプションタグである。 

オプションタグが設定された SOAP アクションを受信した場合、受信した機器で解釈できるオプションタグ

である場合は、受信した機器はオプションタグに設定された内容で動作させ、解釈できなければ、無視する。 

 

10.1.2 値の無い変数（タグ）の扱い 

「M」の必須タグは、そのタグの値が無い場合であっても、SOAP メッセージには値の無いタグ（空タグ）

を記載する。 

「O」のオプションタグは、そのタグの値が無い場合は、SOAP メッセージには記載を省略しても構わない。 

 

10.1.3 SOAPアクションの独自拡張 

能力通知（InformCapability）と能力通知応答（InformCapabilityResponse）、あるいは能力確認要求（GetCapability）

と能力確認応答（GetCapabilityResponse）の"AgentName" タグに記載されている機器種別が同じであること

を前提に、送信機器と受信機器間で利用できる SOAP アクションを独自に定義してもよい。独自に定義する

SOAP メッセージの先頭には「x-」または「X-」を記述すること。 

 

10.1.4 タグの独自拡張 

本プロトコルで規定している SOAP アクションには、変数（タグ）に "Private" タグを設けている。 

能力通知（InformCapability）と能力通知応答（InformCapabilityResponse）、あるいは能力確認要求（GetCapability）

と能力確認応答（GetCapabilityResponse）の"AgentName" タグに記載されている機器種別が同じであること

を前提に、この "Private" タグの子要素に、送信機器と受信機器間で利用できる変数（タグ）を独自に定義

してもよい。独自に定義する変数（タグ）名の先頭に「x-」または「X-」を記述すること。 
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10.2 リクエストメッセージ 

10.2.1  能力通知（InformCapability） 

コンテンツ取得において、クライアントとして動作している機器がサーバとして動作している機器に対して、

クライアントとして動作している機器で扱うことができるコンテンツの種類を通知する。また、クライアン

トとして動作している機器とサーバとして動作している機器間にて、プロトコル種別（プロトコル名/プロト

コルバージョン）及び機器種別（機器名（アプリケーション名）/機器バージョン（アプリケーションバージ

ョン））を通知及び確認するために用いる。 

 

表 10-1／JJ-40.20 能力通知（InformCapability） 

変数（タグ） M/O 内容 

<ct:InformCapability> M － 

 <ct:ProtocolName> M  ・プロトコル種別（プロトコル名/プロトコルバージョン）

を半角英数字で記載する 

 <ct:AgentName> M ・機器種別（機器名（アプリケーション名）/機器バージ

ョン（アプリケーションバージョン））を半角英数字で記

載する 

・複数記載することができる 

 <ct:SupportedFormats> M ・サポートしている MIME-Type すべてをカンマで区切っ

て設定する 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.1.1 <ct:ProtocolName> 

クライアントとして動作している機器のプロトコル種別（プロトコル名/プロトコルバージョン）を記載する。

（9.2.1 項を参照） 

 

■記述方法 

プロトコル名/プロトコルバージョン 

 

例: 

プロトコル名/プロトコルバージョン ⇒ ContentsTransfer/1.0 
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10.2.1.2 <ct:AgentName> 

クライアントとして動作している機器の機器種別（機器名（アプリケーション名）/機器バージョン（アプリ

ケーションバージョン））を記載する。機器種別を複数記述する場合は連続してカンマで区切って記述する。

（9.2.2 項を参照） 

 

■記述方法 

 ・機種種別が 1 つの場合：機器名/機器バージョン 

 ・機種種別が 2 つの場合：機器名/機器バージョン,機器名/機器バージョン 

 

例: 

機器種別が 1 つの場合 ： ContentsTransferApplication/1.0 

機器種別が 2 つの場合 ： ContentsTransferApplication/1.0,ContentsTransferEquipment/1.0 

 

10.2.1.3 <ct:SupportedFormats> 

原則 IANA 登録（http://www.iana.org/assignments/media-types/を参照）された MIME-Type 表記で、応答可能な

すべての能力をカンマで区切った CSV リスト形式で記載する。但し、下記の記述ルールとする。 

 

(1) 正規表現は「*」1 文字だけ対応する（例:「ima*」等には対応しない） 

(2) 「*」（アスタリスク）は「全て」を意味する 

(3) 複数のフォーマットの設定は、「,」（カンマ）区切りで記述する 

(4) 先に記載したものを優先する 

(5) 「!」（エクスクラメーションマーク）は、「否定（NOT）」とする 

(6) 「!」は MIME-Type の先頭に記載することとする 

 

例: 

全てのファイルフォーマットに対応する場合  ⇒ */* 

PNG 形式の画像フォーマットに対応していない場合  ⇒ !image/png  

画像は全て対応しているが、動画は未対応の場合  ⇒ image/*,!video/* 

 

10.2.1.4 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 

 

 
  



－ 38 － ＪＪ－４０．２０ 

 

 

10.2.2  能力確認要求（GetCapability） 

クライアントとして動作している機器からサーバとして動作している機器に対して、コンテンツを送信する

際に、サーバとして動作している機器で扱うことができるコンテンツの種類を確認するために用いる。また、

クライアントとして動作している機器とサーバとして動作している機器間にて、プロトコル種別（プロトコ

ル名/プロトコルバージョン）及び機器種別（機器名（アプリケーション名）/機器バージョン（アプリケー

ションバージョン））を通知及び確認するために用いる。 

 

表 10-2／JJ-40.20 能力確認要求（GetCapability） 

変数 M/O 内容 

<ct:GetCapability> M － 

 <ct:ProtocolName> M  ・プロトコル種別（プロトコル名/プロトコルバージョン）

を半角英数字で記載する 

 <ct:AgentName> M ・機器種別（機器名（アプリケーション名）/機器バージ

ョン（アプリケーションバージョン））を半角英数字で記

載する 

・複数記載することができる 

 <Options> O ・付属資料 Annex で定義する 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.2.1 <ct:ProtocolName> 

クライアントとして動作している機器のプロトコル種別（プロトコル名/プロトコルバージョン）を記載する。

（9.2.1 項を参照） 

 

■記述方法 

プロトコル名/プロトコルバージョン 

 

例: 

プロトコル名/プロトコルバージョン ⇒ ContentsTransfer/1.0 

 

10.2.2.2 <ct:AgentName> 

クライアントとして動作している機器の機器種別（機器名（アプリケーション名）/機器バージョン（アプリ

ケーションバージョン））を記載する。機器種別を複数記述する場合は連続してカンマで区切って記述する。

（9.2.2 項を参照） 

 

■記述方法 

 ・機種種別が 1 つの場合：機器名/機器バージョン 

 ・機種種別が 2 つの場合：機器名/機器バージョン,機器名/機器バージョン 

 

例: 

機器種別が 1 つの場合 ⇒ ContentsTransferApplication/1.0 

機器種別が 2 つの場合 ⇒ ContentsTransferApplication/1.0,ContentsTransferEquipment/1.0 
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10.2.2.3 <Options> 

付属資料 Annex で定義する。 
 

10.2.2.4 <Private> 
子要素に独自タグを設定できる。（10.1.4 項参照） 
 

10.2.3  コンテンツリスト取得要求（GetContentsList） 

クライアントとして動作している機器からサーバとして動作している機器に対して、サーバとして動作して

いる機器に存在するコンテンツのリストを取得する。 

 

表 10-3／JJ-40.20 コンテンツリスト取得要求（GetContentsList） 

変数 M/O 内容 

<ct:GetContentsList> M － 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.3.1 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 

 

10.2.4  ジョブ開始要求（CreateJob） 

クライアントとして動作している機器からサーバとして動作している機器に対して、コンテンツを送信する

際に、送付するコンテンツの容量やフォーマット等、受信するための条件を通知する。 

 

表 10-4／JJ-40.20 ジョブ開始要求（CreateJob） 

変数 M/O 内容 

<ct:CreateJob> M － 

 <ct:ContentName> M ・送信するファイル名を設定する 

 <ct:ContentSize> M ・送信するファイルのサイズをバイト数（Integer 64 bit

の範囲で半角数）で設定する 

 <ct:Format> M ・送信するファイルの MIME-Type を設定する 

 <Options> O ・付属資料 Annex で定義する 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.4.1 <ct:Format> 

原則 IANA 登録（http://www.iana.org/assignments/media-types/を参照）された MIME-Type を設定する。 

 

10.2.4.2 <Options> 

付属資料 Annex で定義する。 
 

10.2.4.3 <Private> 
子要素に独自タグを設定できる。（10.1.4 項参照） 
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10.2.5  コンテンツ取得要求 

接続形態 1 においてコンテンツを取得する際に、コンテンツリスト取得応答（GetContentsListResponse）の

"Path"、"Name" タグに設定された内容のコンテンツを取得するために、HTTP GET メソッドでコンテンツ

リスト取得応答（GetContentsListResponse）の"Path"、"Name" タグに設定されたコンテンツの取得要求を行

う。このためコンテンツ取得要求を行うために新たにSOAPアクションは規定しない。複数のコンテンツを

取得する場合は、HTTP GETメソッドでのコンテンツ取得要求を取得するコンテンツの数だけ繰り返し行う。

（シーケンス図 9-2 参照） 

 

10.2.6  コンテンツ送信 

接続形態 2、接続形態 3 においてジョブ開始（CreateJob）を行った後に行う。クライアントとして動作して

いる機器からサーバとして動作している機器に対してのコンテンツ送信は、HTTP POSTメソッドでRFC1867

及びRFC2388 に従いコンテンツを送信する。なお、コンテンツの境界にはboundaryを使用する。このためコ

ンテンツ送信を行うために新たにSOAPアクションは規定しない。複数のコンテンツを送信する場合は、1

つのコンテンツ毎にジョブ生成フェーズ及びコンテンツ送信フェーズを行い、コンテンツを送信する。つま

りコンテンツの数だけジョブ生成フェーズ及びコンテンツ送信フェーズを繰り返すこととする。（シーケン

ス図 9-3、図 9-4 参照） 
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10.2.7  コンテンツ送信終了（EndSendContent） 

コンテンツ送信（10.2.6 項）によるコンテンツの送信が終了した際、明示的に終了したことを通知したい場

合に、コンテンツ送信終了を行ってもよい。 

または、リクエストメッセージの HTTP ヘッダの " Connection " に "Close" を設定する。 

 

表 10-5／JJ-40.20 コンテンツ送信終了（EndSendContent） 

変数 M/O 内容 

<ct:EndSendContent> M － 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.7.1 <Private> 
子要素に独自タグを設定できる。（10.1.4 項参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 10-1／JJ-40.20 コンテンツ送信終了のシーケンス例 

 

 

  

着呼機器 

（サーバ機能） 

発呼機器 

（クライアント機能） 

TCP セッション切断フェーズ 

呼切断フェーズ 

F49 コンテンツ送信終了<HTTP POST> 

F50 コンテンツ送信終了応答<HTTP 200 OK> 

F47 暫定応答要求<Expect: 100-Continue> 

F48 暫定応答< HTTP/1.1 100 Continue > 

コンテンツ送信フェーズ 
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10.2.8  セッション持続要求（ContinueSession） 

ユーザによるコンテンツ選択操作時にファイル送信の間隔が開いて SOAP メッセージ通信の間隔が開き、能

力通知応答（InformCapabilityResponse）と能力確認応答（GetCapabilityResponse）の"SessionTime" タグに記

載される TCP セッションタイマー値を越える場合、インチャネルの TCP セッションを持続させるため、TCP

セッションタイマー値を越える前に、本セッション持続要求を行い TCP セッションの持続的接続を維持する。

なお、クライアントとして動作している機器から明示的に HTTP セッションの切断指示がない場合、クライ

アントとして動作している機器からのコンテンツの再ジョブ開始要求を許容するため、サーバとして動作し

ている機器は HTTP セッションを切断しないこととする。 

 

表 10-6／JJ-40.20 セッション持続要求（ContinueSession） 

変数 M/O 内容 

<ct:ContinueSession> M － 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.2.8.1 <Private> 
子要素に独自タグを設定できる。（10.1.4 項参照） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 10-2／JJ-40.20 セッション持続のシーケンス例 

着呼機器 

（サーバ機能） 

発呼機器 

（クライアント機能）

TCP セッション切断フェーズ 

呼切断フェーズ 

F53 セッション持続要求<HTTP POST> 

F54 セッション持続要求応答<HTTP 200 OK> 

F51 暫定応答要求<Expect: 100-Continue> 

F52 暫定応答< HTTP/1.1 100 Continue > 

コンテンツ送信フェーズ 

コンテンツ送信フェーズ 

タイマ更新 

ジョブ生成フェーズ 

ジョブ開始 

ジョブ開始応答 

ジョブ生成フェーズ 

ジョブ開始 

ジョブ開始応答 
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10.3 レスポンスメッセージ 

10.3.1  能力通知応答（InformCapabilityResponse） 

コンテンツ取得において、能力通知（InformCapability）を受信した際、サーバとして動作している機器がク

ライアントとして動作している機器に対して、サーバとして動作している機器のプロトコル種別（プロトコ

ル名/プロトコルバージョン）及び機器種別（機器名（アプリケーション名）/機器バージョン（アプリケー

ションバージョン））、TCP セッションタイマー値を応答する。 

 

表 10-7／JJ-40.20 能力通知応答（InformCapabilityResponse） 

変数 M/O 内容 

<ct:InformCapabilityResponse> M － 

 <ct:ProtocolName> M  ・プロトコル種別（プロトコル名/プロトコルバージョン）

を半角英数字で記載する 

 <ct:AgentName> M ・機器種別（機器名（アプリケーション名）/機器バージ

ョン（アプリケーションバージョン））を半角英数字で記

載する 

・複数記載することができる 

 <ct:SessionTime> M ・TCP セッションタイマー値を記載する 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.1.1 <ct:ProtocolName> 

サーバとして動作している機器のプロトコル種別（プロトコル名/プロトコルバージョン）を記載する。（9.2.1

項を参照） 

 

■記述方法 

プロトコル名/プロトコルバージョン 

 

例: 

プロトコル名/プロトコルバージョン ⇒ ContentsTransfer/1.0 

 

10.3.1.2 <ct:AgentName> 

サーバとして動作している機器の機器種別（機器名（アプリケーション名）/機器バージョン（アプリケーシ

ョンバージョン））を記載する。機器種別を複数記述する場合は連続してカンマで区切って記述する。（9.2.2

項を参照） 

 

■記述方法 

 ・機種種別が 1 つの場合：機器名/機器バージョン 

 ・機種種別が 2 つの場合：機器名/機器バージョン,機器名/機器バージョン 

 

例: 

機器種別が 1 つの場合 ⇒ ContentsTransferApplication/1.0 

機器種別が 2 つの場合 ⇒ ContentsTransferApplication/1.0,ContentsTransferEquipment/1.0 
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10.3.1.3 <ct:SessionTime> 

TCPセッションタイマー値を経過するとサーバとして動作している機器からTCPセッションが切断される。

例えば、 "150" と設定した場合、150 秒でTCPセッションが切れる。TCPのセッションを継続する場合は、

TCPセッションタイマー値を経過する前に、クライアントとして動作している機器からサーバとして動作し

ている機器にセッションを持続させるためのアクション（10.2.8 項、10.3.7 項参照）を行う。 

サーバとして動作している機器から本タグで通知される TCP セッションタイマー値は再度 TCP セッション

タイマー値が送信された時点でリフレッシュされる。 

クライアントとして動作している機器は、サーバとして動作している機器から本タグにて通知される最新の

TCP セッションタイマー値で TCP セッションタイマーを管理する。 

 

10.3.1.4 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
 

10.3.2  能力確認応答（GetCapabilityResponse） 

コンテンツ送信において、能力確認要求（GetCapability）に対して、サーバとして動作している機器からク

ライアントとして動作している機器に向け、プロトコル種別（プロトコル名/プロトコルバージョン）及び機

器種別（機器名（アプリケーション名）/機器バージョン（アプリケーションバージョン））、TCP セッション

タイマー値、扱うことができるコンテンツの種類を応答する。 

 

表 10-8／JJ-40.20 能力確認応答（GetCapabilityResponse） 

変数 M/O 内容 

<ct:GetCapabilityResponse> M － 

 <ct:ProtocolName> M  ・プロトコル種別（プロトコル名/プロトコルバージョン）

を半角英数字で記載する 

 <ct:AgentName> M ・機器種別（機器名（アプリケーション名）/機器バージ

ョン（アプリケーションバージョン））を半角英数字で記

載する 

・複数記載することができる 

 <ct:SessionTime> M ・TCP セッションタイマー値を記載する 

 <ct:SupportedFormats> M ・サポートしている MIME-Type すべてをカンマで区切っ

て設定する 

 <Options> O ・付属資料 Annex で定義する 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.2.1 <ct:ProtocolName> 

サーバとして動作している機器のプロトコル種別（プロトコル名/プロトコルバージョン）を記載する。（9.2.1

項を参照） 

 

■記述方法 

プロトコル名/プロトコルバージョン 
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例: 

プロトコル名/プロトコルバージョン ⇒ ContentsTransfer/1.0 
 

10.3.2.2 <ct:AgentName> 

サーバとして動作している機器の機器種別（機器名（アプリケーション名）/機器バージョン（アプリケーシ

ョンバージョン））を記載する。機器種別を複数記述する場合は連続してカンマで区切って記述する。（9.2.2

項を参照） 

 

■記述方法 

 ・機種種別が 1 つの場合：機器名/機器バージョン 

 ・機種種別が 2 つの場合：機器名/機器バージョン,機器名/機器バージョン 

 

例: 

機器種別が 1 つの場合 ⇒ ContentsTransferApplication/1.0 

機器種別が 2 つの場合 ⇒ ContentsTransferApplication/1.0,ContentsTransferEquipment/1.0 

 

10.3.2.3 <ct:SessionTime> 

TCPセッションタイマー値を経過するとサーバとして動作している機器からTCPセッションが切断される。

例えば、 "150" と設定した場合、150 秒でTCPセッションが切れる。TCPのセッションを継続する場合は、

TCPセッションタイマー値を経過する前に、クライアントとして動作している機器からサーバとして動作し

ている機器にセッションを持続させるためのアクション（10.2.8 項、10.3.7 項参照）を行う。 

サーバとして動作している機器から本タグで通知される TCP セッションタイマー値は再度 TCP セッション

タイマー値が送信された時点でリフレッシュされる。 

クライアントとして動作している機器は、サーバとして動作している機器から本タグにて通知される最新の

TCP セッションタイマー値で TCP セッションタイマーを管理する。 

 

10.3.2.4 <ct:SupportedFormats> 

原則 IANA 登録（http://www.iana.org/assignments/media-types/を参照）された MIME-Type 表記で、応答可能な

すべての能力をカンマで区切った CSV リスト形式で記載する。但し、下記の記述ルールとする。 

 

(1) 正規表現は「*」1 文字だけ対応する（例:「ima*」等には対応しない） 

(2) 「*」（アスタリスク）は「全て」を意味する 

(3) 複数のフォーマットの設定は、「,」（カンマ）区切りで記述する 

(4) 先に記載したものを優先する 

(5) 「!」（エクスクラメーションマーク）は、「否定（NOT）」とする 

(6) 「!」は MIME-Type の先頭に記載することとする 

 

例: 

全てのファイルフォーマットに対応する場合  ⇒ */* 

PNG 形式の画像フォーマットに対応していない場合  ⇒ !image/png  

画像は全て対応しているが、動画は未対応の場合  ⇒ image/*,!video/* 
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10.3.2.5 <Options> 

付属資料 Annex で定義する。 

 

10.3.2.6 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
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10.3.3  コンテンツリスト取得応答（GetContentsListResponse） 

コンテンツリスト取得要求（GetContentsList）に対して、サーバとして動作している機器からクライアント

として動作している機器に対して、サーバとして動作している機器に存在するコンテンツのリストを送信す

る。 

 

表 10-9／JJ-40.20 コンテンツリスト取得応答（GetContentsListResponse） 

変数 M/O 内容 XML 文書

*2 

<ct:GetContentsListResponse> M －  

 <ct:ContentsList> M －  

  <ct:Contents 

xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

M － 該当 

   <ct:Content> M － 該当 

    <ct:Path> M ・コンテンツが存在するパス

を設定する 

該当 

    <ct:Name> M ・ファイル名を設定する 該当 

    <ct:Size> M ・ファイルのサイズをバイト

数（Integer 64 bit の範囲で半

角数）で設定する 

該当 

    <ct:Format> M ・ 送 信 す る フ ァ イ ル の

MIME-Type を設定する 

該当 

    <ct:Title> O ・ファイルタイトルを設定す

る 

該当 

    <ct:Description> O ・コンテンツ説明文を設定す

る 

該当 

 <Private> O ・独自拡張用とする  

※「M」=必須、「O」=オプション 

*2：XML 文書として記述することに該当する箇所であることを示す 

 

10.3.3.1 <ct:ContentsList> 

コンテンツリストを示す。子要素を設定する。 

子要素は、10.3.3.2 項～10.3.3.6 項でありSOAPアクション内にXML文書として記述する。 

なお、SOAPアクション内に記述するXML文書の電文は、2 項[XML]に従いエスケープする必要がある文字

があるので注意すること。 

 

10.3.3.2 <ct:Contents xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

リスト化するコンテンツを XML 文書として記述するためのタグである。子要素を設定する。 

 

10.3.3.3 <ct:Content> 

リスト化するコンテンツを示す。子要素を設定する。 

"Contents" タグの子要素として複数設定することを可とする。 
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10.3.3.4 <ct:Format> 

コンテンツファイルの MIME-Type を設定する。 

原則 IANA 登録（http://www.iana.org/assignments/media-types/を参照）された MIME-Type を設定する。 
 

10.3.3.5 <ct:Title> 

コンテンツファイルのタイトルを設定する。ファイルのタイトルを設定しないことも可とする。 

コンテンツファイルのタイトルを設定しない、つまり"Title" タグの値が空きである場合でも必ず"Content"

タグに空タグを設定する。（10.1.2 項参照） 

 

10.3.3.6 <ct:Description> 

コンテンツ説明文を設定する。コンテンツ説明文を設定しないことも可とする。 

コンテンツ説明文を設定しない、つまり"Description" タグ の値が空きである場合でも必ず"Content" タグに

空タグを設定する。（10.1.2 項参照） 

 

10.3.3.7 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
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10.3.4  ジョブ開始応答（CreateJobResponse） 

ジョブ開始要求（CreateJob）に対して、サーバとして動作している機器からクライアントとして動作してい

る機器に向け、コンテンツを受信する際に、JobID や送信先のパスを通知する。 

 

表 10-10／JJ-40.20 ジョブ開始応答（CreateJobResponse） 

変数 M/O 内容 

<ct:CreateJobResponse> M － 

 <ct:JobID> M ・ジョブ識別子（Integer 32 bit の範囲で半角数）を設定

する 

 <ct:Path> M ・ファイル送信の HTTP POST メソッドの宛先

Request-URI を設定する 

 <Options> O ・付属資料 Annex で定義する 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.4.1 <ct:JobID > 

"JobID" タグは、ジョブ開始要求（CreateJob）に対する応答を行う際に通知する。 

ジョブ開始要求で通知されるファイル容量やファイルフォーマット等の条件で受信可能な場合、ジョブ開始

要求に対する応答時に"JobID" タグに jobID を設定して通知する。 

 

ジョブ開始要求で通知される条件で受信できない場合、JobID には下記の ID（エラーコード）を通知して受

信を拒否する。 

 

-1 ＝ 不正なファイル名による受信拒否 

-2 ＝ 容量オーバによる受信拒否 

-3 ＝ 未対応ファイルフォーマットによる受信拒否 

-4 ＝ "Options"、"Private" タグに理解不能な値があり受信拒否したい場合 
（受信拒否せず無視する場合は、-4 を通知せず JodID を設定する） 

 

10.3.4.2 <Options> 

付属資料 Annex で定義する。 

 

10.3.4.3 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 
 

10.3.5 コンテンツ取得送信 

接続形態 1 において、HTTP GET メソッドのコンテンツ取得要求に対して、HTTP1.1 200 OK で要求されたコ

ンテンツを送信する。SOAP アクションは規定しない。 
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10.3.6 コンテンツ送信終了応答（EndSendContentResponse） 

コンテンツ送信終了（EndSendContent）に対して、返送する。 

シーケンス図は図 10-1 を参照。 

 

表 10-11／JJ-40.20 コンテンツ送信終了応答（EndSendContentResponse） 

変数 M/O 内容 

<ct:EndSendContentResponse> M － 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.6.1 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 

 

10.3.7  セッション持続応答（ContinueSessionResponse） 

セッション持続（ContinueSession）に対して、サーバとして動作している機器からクライアントとして動作

している機器に向け、「InformCapabilityResponse や GetCapabilityResponse にて通知した TCP セッションタイ

マー値の更新要求に対して、応答を返す。 

TCPセッションタイマー値の通知は、能力通知応答（ InformCapabilityResponse）と能力確認応答

（GetCapabilityResponse）の"SessionTime" タグに記載する。（10.3.1 項、10.3.2 項参照） 

シーケンス図は図 10-2 を参照。 

 

表 10-12／JJ-40.20 セッション持続応答（ContinueSessionResponse） 

変数 M/O 内容 

<ct:ContinueSessionResponse> M － 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

10.3.7.1 <Private> 

子要素に独自タグを設定できる。（10.1.4 項参照） 

 

11 エラーコードの規定 

SOAP メッセージの処理中に発生したエラーを SOAP 規定のエラーコードを使って通知することができる。 

利用できるエラーコードを表 11-1 に示す。 

SOAPアクション（10.3.4.1 項）で規定しているエラー内容については、SOAPアクションを使って通知する

こと。 

 

表 11-1／JJ-40.20 エラーコードの規定 

エラーコード 

（SOAP 規定）*3 

サブコード 

（独自規定） 

詳細 対応 SOAP アクション 

VersionMismatch － 無効なネームスペースを発見 全て 

DataEncodingUnknown － 電文のエンコードが解釈不能 全て 
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*3：http://www.w3.org/2003/05/soap-envelope を参照 

12 準正常系、異常系の動作規定 

12.1 準正常系の動作規定 

 

 

表 12-1／JJ-40.20 準正常系の動作規定 

項番 状況 対応策 

1 「能力通知（InformCapability）と能力通知応

答（InformCapabilityResponse）、あるいは能力

確認要求（GetCapability）と能力確認応答

（GetCapabilityResponse）」の"ProtocolName" 

タグ 

に記載されているプロトコル識別のプロト

コルバージョンが違った場合 

・下位バーションで動作する 

・上位バージョンを実装している機器は下位互換

を確保する 

2 「能力通知（InformCapability）と能力通知応

答（InformCapabilityResponse）、あるいは能力

確認要求（GetCapability）の能力確認応答

（GetCapabilityResponse）」の"AgentName" タ

グに記載されている機器名（アプリケーショ

ン名）が違った場合 

・独自に定義したSOAPアクションと"Private" タ

グの子要素に定義した変数（タグ）は無視し、本

プロトコルで規定する動作を行う（9.2 項参照）

3 「能力通知応答（InformCapabilityResponse）

と能力確認応答（GetCapabilityResponse）」の

"SessionTime" タグに記載している TCP セッ

ションタイマー値が無かった場合 

・TCP セッションは切断されないとして動作する

4 コンテンツ送信側機器がサポートするファ

イルフォーマットが、コンテンツ受信側機器

で扱えない場合 

・発呼機器から TCP セッション及び呼を切断す

る 

5 SOAP メッセージの"Options"、"Private" タグ

の内容が理解できない場合 

・無視する 

・ 拒 否 し た い 場 合 は 、 ジ ョ ブ 開 始 応 答

（CreateJobResponse）の"JobID" タグにエラーコ

ードを設定して通知する（10.3.4 項参照） 

・"Private" タグの子要素の設定はコンテンツ送信

側機器とコンテンツ受信側機器で利用できるよ

うに設定する（10.1.4 項参照） 

6 コンテンツ受信側機器で受信したくないフ

ァイルフォーマットを指定したい場合 

・能力通知要求（InformCapability）もしくは能力

確 認 応 答 （ GetCapabilityResponse ） の

"SupportedFormats" タグの設定に「!」を設定して

受信拒否したい旨を通知する（10.2.1 項、10.3.2

項参照） 

7 コンテンツ送信を開始する際、ファイル容量

オーバ等の何らかの原因でコンテンツ受信

側機器が受信拒否したい場合 

・ジョブ開始応答（CreateJobResponse）の"JobID"

タグにエラーコードを設定して通知する（10.3.4

項参照） 
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8 コンテンツ送信中に受信側の機器のメモリ

不足等によりコンテンツ送信を待たせたい

場合 

・受信側の機器は送信側の機器に TCP の ACK を

返さない 

9 サーバとして動作している機器が、「Expect: 

100-continue」が付与されていないリクエスト

を受信した場合 

・ボディ部も含まれていると想定し、ボディ部の

受信が完了した後、200 OK を返却する 

10 サーバとして動作している機器が、「Expect: 

100-contine」が付与されているボディ部も含

まれたリクエストを受信した場合  

・ボディ部の受信が完了した後、200 OK を返却

する 

11 サーバとして動作している機器が、「Expect: 

100-contine」が付与されているヘッダ部のみ

記載されたリクエストを受信し、「HTTP/1.1 

100 Continue」を返信したが、一定時間経過

してもボディ部を受信しない場合 

・HTTP ステータスコードでエラーレスポンスを

返却後、呼を切断する 

12 クライアントとして動作している機器が、

「Expect: 100-contine」を送信したにもかかわ

らず、サーバとして動作している機器からの

レスポンスが無い場合 

・レスポンス「HTTP/1.1 100 Continue」が返送さ

れなくても一定時間経過すればボディ部の送出

を開始する 

13 コンテンツ送信終了（EndSendContent）が通

知されずに切断された場合 

・コンテンツは全て送信されたとして終了する 

14 F37 コンテンツ送信（HTTP POST）が、コン

テンツデータ前の boundary の前及びコンテ

ンツデータ後のboundaryの後にCRLFが入り

受信できない場合、及び入っていなくて受信

できない場合 

・RFC2046 5.1.1.  Common Syntax に記載されて

いる通り、CRLF はオプション扱いであるため、

理解しコンテンツを受信する 

15 TCP コネクションの確立時、SYN パケット

を送出後に相手から RST パケットが返って

きた場合 

・同一の src ポート番号及び dst ポート番号を使

用して SYN パケットの再送を行うことを推奨す

る 

・再送した SYN パケットに対しても RST パケッ

トが返ってきた場合には、呼を切断する 
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12.2 異常系の動作規定 

 

表 12-2／JJ-40.20 異常系の動作規定 

項番 状況 対応策 

1 コンテンツ送信側機器からの能力確認要

求（GetCapability）に"SupportedFormats" タ

グが設定されていた場合 

・無視する 

・"Private" タグの子要素を利用して能力を通知する

場合はコンテンツ送信側機器とコンテンツ受信側

機器で利用できるように設定する（10.1.4 項参照）

2 コンテンツ受信側で受信した SOAP アク

ションに、規定にないタグが記載されてい

た場合 

・無視する 

・HTTP ステータスコードでエラーレスポンスを返

信する 

・"Private" タグの子要素にタグを設定する場合はコ

ンテンツ送信側機器とコンテンツ受信側機器で利

用できるように設定する（10.1.4 項参照） 

3 SOAP リクエストメッセージを送信した

が、SOAP レスポンスメッセージが返って

こない場合 

・30 秒経過しても返ってこない場合は、何らかの原

因で相手機器が接続をはずされたとして終了する 

4 HTTP セッションが切断された場合 ・HTTP の再接続は行わず、シーケンスは終了した

とし、呼を切断する 

・再度、コンテンツ送信を実施する場合は、発呼か

ら開始する 

5 予期せぬ FIN や RST などでコンテンツフ

ァイルの送受信中に TCP セッションが切

断された場合 

・TCP の再接続は行わず、シーケンスは終了したと

し、呼を切断する 

・再度、コンテンツ送信を実施する場合は、発呼か

ら開始する 
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13 各メッセージ例 

本標準で記述する HTTP 構文、XML 文書は、BN 記法に従い、参照する RFC 等の参考文献の内容に沿って

記述する。 

 

13.1 F1 SIP接続要求＜INVITE＞ 

INVITE ･･････ 

（中略） 

v=0 

o=- 634249773347155741 634249773347155741 IN IP4 client.kyoto.example.ne.jp 

s=- 

c=IN IP4 xxx.xxx.xxx.xxx 

t=0 0 

m=application 9 TCP xxxx 

b=AS:2000 

a=setup:active 

a=connection:new 

 

※注意点 

・SIP の記述は、JT-Q3402、JF-IETF-RFC4145 に従う。 

・"a=setup" にて、クライアント動作／サーバ動作を決定する（表 9-4 参照） 

 

 

13.2 F4 SIP応答＜200 OK＞ 

SIP/2.0 200 OK 

･･････ 

（中略） 

v=0 

o=- 0 0 IN IP4 client.kyoto.example.ne.jp 

s=- 

c=IN IP4 xxx.xxx.xxx.xxx 

t=0 0 

m=application 10000 TCP xxxx 

c=IN IP4 xxx.xxx.xxx.xxx 

b=AS:2000 

a=setup:passive 

a=connection:new 

 

※注意点 

・SIP の記述は、JT-Q3402、JF-IETF-RFC4145 に従う。 

・"a=setup"にて、クライアント動作／サーバ動作を決定する（表 9-4 参照） 
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13.3 F8 SIPメディア追加要求＜UPDATE＞ 

UPDATE ･･････ 

（中略） 

v=0 

o=- 634249773347155741 634249773347155741 IN IP4 client.kyoto.example.ne.jp 

s=- 

c=IN IP4 xxx.xxx.xxx.xxx 

t=0 0 

m=application 9 TCP xxxx 

b=AS:2000 

a=setup:active 

a=connection:new 

 

※注意点 

・SIP の記述は、JT-Q3402、JF-IETF-RFC4145 に従う。 

・"a=setup" にて、クライアント動作／サーバ動作を決定する（表 9-4 参照） 

 

 

13.4 F9 SIP応答＜200 OK＞ 

SIP/2.0 200 OK 

･･････ 

（中略） 

v=0 

o=- 0 0 IN IP4 client.kyoto.example.ne.jp 

s=- 

c=IN IP4 xxx.xxx.xxx.xxx 

t=0 0 

m=application 10000 TCP xxxx 

c=IN IP4 xxx.xxx.xxx.xxx 

b=AS:2000 

a=setup:passive 

a=connection:new 

 

※注意点 

・SIP の記述は、JT-Q3402、JF-IETF-RFC4145 に従う。 

・"a=setup"にて、クライアント動作／サーバ動作を決定する（表 9-4 参照） 
 

 

13.5 F11 暫定応答要求（Expect: 100-continue） 

POST /soap_action HTTP/1.1 

Content-Length: 318 

Content-Type: application/soap+xml; charset="utf-8"; 

Connection: Keep-Alive 
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Expect: 100-continue 

Host: xxx.xxx.xxx.xxx:10000 

 

 

13.6 F12 暫定応答（HTTP/1.1 100 Continue） 

HTTP/1.1 100 Continue 

Connection: Keep-Alive 

 

13.7 F13 能力通知（InformCapability） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:InformCapability> 

      <ct:ProtocolName> ContentsTransfer/1.0</ct:ProtocolName> 

      <ct:AgentName>ContentsTransferApplication/1.0,ContentsTransferEquipment/1.0</ct:AgentName>         

<ct:SupportedFormats>image/jpg,image/tiff,!application/*</ct:SupportedFormats> 

    </ct:InformCapability> 

  </env:Body> 

</env:Envelope> 

 

13.8 F14 能力通知応答（InformCapabilityResponse） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:InformCapabilityResponse> 

     <ct:ProtocolName>ContentsTransfer/1.0</ct:ProtocolName> 

      <ct:AgentName>ContentsTransferApplication/1.0,ContentsTransferEquipment/1.0</ct:AgentName> 

      <ct:SessionTime>150</ct:SessionTime> 

   <ct:SupportedFormats>image/jpg,image/tiff,!application/*</ct:SupportedFormats> 

  </env:Body> 

</env:Envelope> 

 

 

13.9 F17 コンテンツリスト取得要求（GetContentsList） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 
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    <ct:GetContentsList > 

  </ct:GetContentsList > 

  </env:Body> 

</env:Envelope> 

 

 

13.10 F18 コンテンツリスト取得応答（GetContentsListResponse） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:GetContentsListResponse> 

      <ct:ContentsList> 

        &lt;?xml version="1.0" encoding="UTF-8"?&gt; 

     &lt;ct:Contents xmlns:ct="http://www.ttc.or.jp/mmsys/ct"&gt; 

      &lt;ct:Content&gt; 

            &lt;ct:Path&gt;/photo&lt;/ct:Path&gt; 

            &lt;ct:Name&gt;Photo001.jpg&lt;/ct:Name&gt; 

            &lt;ct:Size&gt;326863&lt;/ct:Size&gt; 

            &lt;ct:Format&gt;image/jpeg&lt;/ct:Format&gt; 

            &lt;ct:Title&gt;Travel Photo No1&lt;/ct:Title&gt; 

            &lt;ct:Description&gt;旅行に行ったときの写真 1&lt;/ct:Description&gt; 

          &lt;/ct:Content&gt; 

          &lt;ct:Content&gt; 

            &lt;ct:Path&gt;/photo&lt;/ct:Path&gt; 

            &lt;ct:Name&gt;Photo002.jpg&lt;/ct:Name&gt; 

            &lt;ct:Size&gt;180421&lt;/ct:Size&gt; 

            &lt;ct:Format&gt;image/jpeg&lt;/ct:Format&gt; 

            &lt;ct:Title&gt;Travel Photo No2&lt;/ct:Title&gt; 

            &lt;ct:Description&gt;旅行に行ったときの写真 2&lt;/ct:Description&gt; 

          &lt;/ct:Content&gt; 

     &lt;/ct:Contents&gt; 

      </ct:ContentsList> 

    </ct:GetContentsListResponse> 

  </env:Body> 

</env:Envelope> 

 

 

13.11 F21 コンテンツ 1 要求<HTTP GET> 

GET /Photo001.jpg HTTP/1.1 

Accept: image/jpeg 

Connection: Keep-Alive 
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Host: xxx.xxx.xxx.xxx:10000 

 

※注意点 

URL は、コンテンツリスト取得応答の<ct:Path>, <ct:Name>を使用 
 
 

13.12 F22 コンテンツ 1 取得送信<HTTP 200 OK> 

HTTP/1.1 200 OK 

Connection: Keep-Alive 

Content-Type: image/jpeg 

Content-Length: xxx 

 

（データ） 

 

 

13.13 F29 能力確認要求（GetCapability） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:GetCapability> 

      <ct:ProtocolName>ContentsTransfer/1.0</ct:ProtocolName> 

      <ct:AgentName>ContentsTransferApplication/1.0,ContentsTransferEquipment/1.0</ct:AgentName> 

  </ct:GetCapability> 

  </env:Body> 

</env:Envelope> 

 

 

13.14 F30 能力確認応答（GetCapabilityResponse） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:GetCapabilityResponse> 

   <ct:ProtocolName>ContentsTransfer/1.0</ct:ProtocolName> 

      <ct:AgentName>ContentsTransferApplication/1.0,ContentsTransferEquipment/1.0</ct:AgentName> 

      <ct:SessionTime>150</ct:SessionTime> 

      <ct:SupportedFormats>image/jpg,image/tiff,!application/*</ct:SupportedFormats> 

    </ct:GetCapabilityResponse> 

  </env:Body> 

</env:Envelope> 
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13.15 F33 ジョブ開始要求（CreateJob） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:CreateJob> 

      <ct:ContentName>Photo002.jpg</ct:ContentName> 

      <ct:ContentSize>180421</ct:ContentSize> 

      <ct:Format>image/jpeg</ct:Format> 

    </ct:CreateJob> 

  </env:Body> 

</env:Envelope> 

 

 

13.16 F34 ジョブ開始応答（CreateJobResponse） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:CreateJobResponse> 

      <ct:JobID>28</ct:JobID> 

      <ct:Path>/photodata</ct:Path> 

    </ct:CreateJobResponse> 

  </env:Body> 

</env:Envelope> 

 

 

13.17 F37 コンテンツ 1 送信<HTTP POST> 

--7da11b1cd70ac2 

Content-Disposition: form-data; name="xxx"; filename=" Photo002.jpg " 

Content-Type: image/jpeg 

 

(データ) 

--7da11b1cd70ac2— 
 

 

13.18 F49 コンテンツ送信終了（EndSendContent） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 
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  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:EndSendContent> 

  </ct:EndSendContent> 

  </env:Body> 

</env:Envelope> 
 
 

13.19 F50 コンテンツ送信終了応答（EndSendContentResponse） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:EndSendContentResponse > 

  </ct:EndSendContentResponse> 

  </env:Body> 

</env:Envelope> 
 
 

13.20 F53 セッション持続要求（ContinueSession） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:ContinueSession > 

  </ct:ContinueSession> 

  </env:Body> 

</env:Envelope> 
 
 

13.21 F54 セッション持続応答（ContinueSessionResponse） 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

    <ct:ContinueSessionResponse > 

  </ct:ContinueSessionResponse> 

  </env:Body> 

</env:Envelope> 
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13.22 エラーメッセージ 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope 

  xmlns:env="http://www.w3.org/2003/05/soap-envelope" 

  xmlns:ct="http://www.ttc.or.jp/mmsys/ct"> 

  <env:Body> 

  <env:Fault> 

   <env:Code> 

    <env:Value>env: VersionMismatch</env:Value> 

   </env:Code> 

<env:Reason> 

       <env:Text xml:lang="en">Version Mismatch</env:Text> 

     </env:Reason> 

  </env:Fault> 

  </env:Body> 

</env:Envelope> 
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14 本編記載のSOAPメッセージのXMLスキーマ 
 

<?xml version="1.0" encoding="UTF-8"?> 

<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

  targetNamespace="http://www.ttc.or.jp/mmsys/ct" xmlns:ct="http://www.ttc.or.jp/mmsys/ct" 

  elementFormDefault="unqualified" attributeFormDefault="unqualified"> 

 

  <xs:element name="InformCapability"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element ref="ct:ProtocolName" /> 

    <xs:element ref="ct:AgentName" /> 

        <xs:element ref="ct:SupportedFormats" /> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

 <xs:element type="xs:string" name="ProtocolName" /> 

 

 <xs:element type="xs:string" name="AgentName" /> 

 

  <xs:element type="xs:string" name="SupportedFormats" /> 

 

  <xs:element name="GetCapability"> 

    <xs:complexType> 

      <xs:sequence> 

    <xs:element ref="ct:ProtocolName" /> 

    <xs:element ref="ct:AgentName" /> 

        <xs:element name="Options" minOccurs="0" /> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="GetContentsList"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 
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  </xs:element> 

 

  <xs:element name="CreateJob"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element ref="ct:ContentName" /> 

        <xs:element ref="ct:ContentSize" /> 

        <xs:element ref="ct:Format" /> 

        <xs:element name="Options" minOccurs="0"> 

        </xs:element> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element type="xs:string" name="ContentName" /> 

 

  <xs:element name="ContentSize"> 

    <xs:simpleType> 

      <xs:restriction base="xs:long"> 

        <xs:minInclusive value="0" /> 

        <xs:maxInclusive value="9223372036854775807" /> 

      </xs:restriction> 

    </xs:simpleType> 

  </xs:element> 

 

  <xs:element type="xs:string" name="Format" /> 

 

  <xs:element name="EndSendContent"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="ContinueSession"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 
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  <xs:element name="InformCapabilityResponse"> 

    <xs:complexType> 

      <xs:sequence> 

    <xs:element ref="ct:ProtocolName" /> 

    <xs:element ref="ct:AgentName" /> 

    <xs:element ref="ct:SessionTime" /> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

 <xs:element type="xs:string" name="SessionTime" /> 

 

  <xs:element name="GetCapabilityResponse"> 

    <xs:complexType> 

      <xs:sequence> 

    <xs:element ref="ct:ProtocolName" /> 

    <xs:element ref="ct:AgentName" /> 

    <xs:element ref="ct:SessionTime" /> 

        <xs:element ref="ct:SupportedFormats" /> 

        <xs:element name="Options" minOccurs="0" /> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="GetContentsListResponse"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element ref="ct:ContentsList" /> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="ContentsList"> 

    <xs:complexType> 

      <xs:sequence maxOccurs="unbounded"> 

        <xs:element ref="ct:Contents" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 
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<xs:element name="Contents"> 

    <xs:complexType> 

      <xs:sequence maxOccurs="unbounded"> 

        <xs:element ref="ct:Content" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="Content"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element ref="ct:Path" /> 

        <xs:element ref="ct:Name" /> 

        <xs:element ref="ct:Size" /> 

        <xs:element ref="ct:Format" /> 

        <xs:element ref="ct:Title" minOccurs="0" /> 

        <xs:element ref="ct:Description" minOccurs="0" /> 

        <xs:element name="Options" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element type="xs:string" name="Path" /> 

 

  <xs:element type="xs:string" name="Name" /> 

 

  <xs:element name="Size"> 

    <xs:simpleType> 

      <xs:restriction base="xs:long"> 

        <xs:minInclusive value="0" /> 

        <xs:maxInclusive value="9223372036854775807" /> 

      </xs:restriction> 

    </xs:simpleType> 

  </xs:element> 

 

  <xs:element type="xs:string" name="Title" /> 

 

  <xs:element type="xs:string" name="Description" /> 

 

  <xs:element name="CreateJobResponse"> 

    <xs:complexType> 

      <xs:sequence> 
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        <xs:element ref="ct:JobID" /> 

        <xs:element ref="ct:Path" /> 

        <xs:element name="Options" minOccurs="0" /> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="JobID"> 

    <xs:simpleType> 

      <xs:restriction base="xs:int"> 

        <xs:minInclusive value="-4" /> 

        <xs:maxInclusive value="2147483647" /> 

      </xs:restriction> 

    </xs:simpleType> 

  </xs:element> 

 

  <xs:element name="EndSendContentResponse"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

  <xs:element name="ContinueSessionResponse"> 

    <xs:complexType> 

      <xs:sequence> 

        <xs:element name="Private" minOccurs="0" /> 

      </xs:sequence> 

    </xs:complexType> 

  </xs:element> 

 

</xs:schema> 
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15 おわりに 

本標準では、NGN 環境下の SOAP/HTTP を利用したコンテンツ転送システムについて、コンテンツを送信機

器から受信機器に送る基本的仕様に注力し記述している。今後の拡張は付属資料（Annex）に記載する。 
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付属資料 Annex 

 

今後規定する。 
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付録 A  JJ-40.20 制定前の技術レポート TR-1038 との相互接続 

 

JJ-40.20 制定前の技術レポート TR-1038 では、SOAP アクション「能力通知（InformCapability）、能力通知応

答（InformCapabilityResponse）、能力確認要求（GetCapability）、能力確認応答（GetCapabilityResponse）」の

"ProtocolName" タグと"AgentName" タグに記載しているプロトコル種別（プロトコル名、プロトコルバージ

ョン）及び機器種別（機器名、機器バージョン）を、HTTP ヘッダの "User-Agent" と "Server"に記載してい

た。 

TR-1038 を実装した機器との相互接続を考慮する場合には、SOAP アクションにプロトコル種別及び機器種

別記載されていないため、HTTP ヘッダの "User-Agent" と "Server"に記載するプロトコル種別及び機器種別

を理解することができるように実装する必要がある。 

なお、SOAP アクションと HTTP ヘッダの両方にプロトコル種別、端末種別が記載されている場合は、SOAP

アクションに記載されているプロトコル種別、端末種別を優先する。 

JJ-40.20 制定前の技術レポート TR-1038 に記載している HTTP ヘッダの "User-Agent" と "Server"の記述方法

は下記である。 

 

■User-Agent の記述方法 

クライアントとして動作している機器からのリクエストの HTTP ヘッダの "User-Agent" に、RFC2616 に従

いコメントとして、プロトコル種別（プロトコル名、プロトコルバージョン）及び、機器種別（機器名（ア

プリケーション名）、機器バージョン（アプリケーションバージョン））を記載する。 

機器種別を複数記述する場合はカンマで区切って記述する。 

 

User-Agent:<SP><プロトコル名>/<プロトコルバージョン><SP>(<機器名>;<SP><機器バージョン>;) 

 

表 a-1／TR-1038 User-Agent の設定内容 

項目 設定内容 

<SP> "%x20" （半角スペース） 

<プロトコル名> 表 9-3 に従い設定する 

<プロトコルバージョン> 表 9-3 に従い設定する 

<機器名> 半角英数字で設定する 

<機器バージョン> 半角英数字で設定する 

 

■Server の記述方法 

サーバとして動作している機器からのレスポンスのHTTPヘッダの "Server" に、RFC2616 に従いコメントと

してプロトコル識別（プロトコル名、プロトコルバージョン）及び、機器種別（機器名（アプリケーション

名）、機器バージョン（アプリケーションバージョン））、TCPセッションタイマー値（10.3.1.3 項を参照）を

記載する。機器種別を複数記述する場合はカンマで区切って記述する。 

 

Server:<SP><プロトコル名>/<プロトコルバージョン><SP>(<機器名>;<SP><機器バージョン>;)<SP>x:<TCP

セッションタイマー値（秒）>; 
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表 a-2／TR-1038 Server の設定内容 

項目 設定内容 

<SP> "%x20" （半角スペース） 

<プロトコル名> 表 9-3 に従い設定する 

<プロトコルバージョン> 表 9-3 に従い設定する 

<機器名> 半角英数字で設定する 

<機器バージョン> 半角英数字で設定する 

<TCP セッションタイマー値（秒）> 半角数字で設定する 
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